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Chapter 1 • Introduction

In recent times, the development of System on a Chip (Soc) has lead to the popular use of 
microcontrollers . Many products sold today will have one or more microcontrollers found 
inside . Their small size, low cost, and increasing capabilities make them very compelling . 
Beginning in 2005, the Arduino project made microcontrollers more accessible to students 
by simplifying the programming environment .[1] Since then, hobbyists and engineers alike 
have exploited its capabilities .

More recently, FreeRTOS within the Arduino software framework has been introduced on 
some platforms . Why is FreeRTOS beneficial? What problems does it solve? How can FreeR-
TOS be leveraged by your project? These are some of the questions answered in this book 
with demonstrations .

Not all Arduino hardware platforms support FreeRTOS . The RTOS (Real-Time Operating 
System) component requires additional resources like SRAM (Static Random Access Mem-
ory) and a stack for each task . Consequently, very small microcontrollers won’t support 
it . For larger microcontrollers that do, a rich API (Application Programming Interface) is 
available to make writing your application easier and more powerful .

The Need for RTOS
The general approach used on small AVR (ATmel) devices is to poll for events and respond . 
A program might test for button presses, incoming serial data, take temperature readings, 
and then at the right time, produce a result like closing relays or sending serial data . That 
polling approach works well enough for small projects .

As the number of input events and conditions increases, the complexity tends to multiply . 
Managing events by polling requires an ever-increasing management of state . Well de-
signed programs may, in fact, implement a formal "state machine" to organize this com-
plexity .

If instead, the same program was split into independently executing subprograms, the 
problem becomes much simpler to manage . Within FreeRTOS, these are known as tasks . 
The button press task could examine the GPIO input and debounce it . It becomes a sim-
ple loop of its own, producing an event only when the debounced result indicates that the 
button was pressed . Likewise, the serial input task operating independently can loop while 
receiving characters until an end of line character was encountered . Once the serial data 
was decoded, the interpreted command could signal an event . Finally, the master task, re-
ceiving both the button press and command events from other tasks can trigger an action 
event (like the closing of relays) . In this manner, a complex application breaks down into 
smaller tasks, with each task focusing on a subset of the problem .

How are tasks implemented? In the early years of computing, mainframes could only run 
one program at a time . This was an expensive way to use a computer that occupied the 
size of a room . Eventually, operating systems emerged, with names like the Time Sharing 
Option (TSO), which made it possible to share that resource with several users (all running 
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different programs) . These early systems gave the illusion of running multiple programs 
at the same time by using a trick: after the current time slice was used up, the program’s 
registers were saved, and another program’s registers were reloaded, to resume the sus-
pended program . Performed many times per second, the illusion of multiple programs run-
ning at once was complete . This is known as concurrent execution since only one program 
is running at any one instant .

A similar process happens today on microcontrollers using an RTOS . When a task starts, 
the scheduler uses a hardware timer . Later, when the hardware timer causes an interrupt, 
the scheduler suspends the current task and looks for another task to resume . The cho-
sen task’s registers are restored, and the new (previously suspended) task resumes . This 
concurrent execution is also known as preemptive scheduling because one task preempts 
another when the hardware timer interrupts .

Preemptive scheduling is perhaps the main reason for using FreeRTOS in today’s projects . 
Preemptive scheduling permits concurrent execution of tasks, allowing the application de-
signer to subdivide complex applications without having to plan the scheduling . Each com-
ponent task runs independently while contributing to the overall solution .

When there are independent tasks, new issues arise . How does a task safely communicate 
an event to another task? How do you synchronize? How do interrupts fit into the frame-
work? The purpose of this book is to demonstrate how FreeRTOS solves these multitasking 
related problems .

FreeRTOS Engineering
It would be easy to underestimate the design elegance of FreeRTOS . I believe that some 
hobbyists have done as much in forums . Detractors talk about the greater need for effi-
ciency, less memory, and how they could easily implement their routines instead . While 
this may be true for trivial projects, I believe they have greatly underestimated the scope 
of larger efforts .

It is fairly trivial to design a queue with a critical section to guarantee that one of several 
tasks receives an item atomically . But when you factor in task priorities, for example, the 
job becomes more difficult . FreeRTOS guarantees that the highest priority task will receive 
that first item queued . Further, if there are multiple tasks at the same priority, the first 
task to wait on the queue will get the added item . Strict ordering is baked into the design 
of FreeRTOS .

The mutex is another example of a keen FreeRTOS design . When a high priority task at-
tempts to lock a mutex that is held by a lower priority task, the later’s priority is increased 
temporarily so that the lock can be released earlier, to prevent deadlocks . Once released, 
the task that was holding the mutex returns to its original priority . These are features that 
the casual user takes for granted .

The efficiency argument is rarely the most important consideration . Imagine your appli-
cation written for one flavour of RTOS and then in another . Would the end-user be able to 
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tell the difference? In many cases, it would require an oscilloscope measurement to note 
a difference .

FreeRTOS is one of several implementations that are available today . However, it’s free 
status and its first-class design and validation make it an excellent RTOS to study and use . 
FreeRTOS permits you to focus on your application rather than to recreate and validate a 
home-baked RTOS of your own .

Hardware
To demonstrate the use of the FreeRTOS API, it is useful to concentrate on one hardware 
platform . This eases the requirements for the demonstration programs . For this reason, the 
Espressif ESP32 is used throughout this book, which can be purchased at a modest cost . 
These devices have enough SRAM to support multiple tasks and have the facilities neces-
sary to support preemptive scheduling . Even more exciting, is the fact that these devices 
can also support WiFi and TCP/IP networking for advanced projects .

Dev Boards
While almost any ESP32 module could be used, the reader is encouraged to use the "dev 
board" variety for this book . The non-dev board module requires a TTL to serial device to 
program its flash memory and communicate with . Be aware that many TTL to serial devices 
are 5 volts only . To prevent permanent damage, these should not be used with the 3 .3 volt 
ESP32 . TTL to serial devices can be purchased, which do support 3 .3 volts, usually with a 
jumper setting .

The dev boards are much easier to use because they include a USB to serial chip onboard . 
They often use the chip types CP2102, CP2104, or CH340 . Dev boards will have a USB 
connector, which only requires a USB cable to plug into your desktop . They also provide 
the necessary 5 volts to 3 .3-volt regulator to power your ESP32 .  GPIO 0 is sometimes 
automatically grounded by the dev board, which is required to start the programming . The 
built-in USB to serial interface makes programming the device a snap and permits easy 
display of debugging information in the Arduino Serial Monitor . Dev boards also provide 
easy GPIO access with appropriate labels and are breadboard friendly (when the header 
strips are added) . The little extra spent on the dev board is well worth the convenience and 
the time it will save you .

One recommended unit is the ESP32 Lolin with OLED because it includes the OLED display . 
It is priced a little higher because of the display but it can be very useful for end user ap-
plications . Most ESP32 devices are dual-core (two CPUs), and the demonstrations in this 
book assume as much .

If you are determined to use the nondev board variety, perhaps because you want to 
use the ESP32CAM type of board, then the choice of USB to TTL serial converter might 
be important . While the FT232RL eBay units offer a 3 .3-volt option, I found that they are 
problematic for MacOS (likely not for Windows) . If the unit is unplugged or jiggled while the 
device is in use, you lose access to the device, and replugging the USB cable doesn’t help . 
Thus it requires the pain of rebooting and is, therefore, best avoided .
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Table 1-1 summarizes the major Espressif product offerings that will populate various de-
velopment boards . When buying, zoom in on the CPU chip in the photo for identifying 
marks . There are other differences between them in terms of peripheral support etc ., not 
shown in the table . Those details can be discovered in the Espressif hardware PDF data-
sheets . All examples in this book assume the dualcore CPU to run without modification . The 
demonstrations can be modified to work on a single core unit but when learning something 
new, it is best to use tested examples first .

Series Cores CPU Clock SRAM + RTC Marking

ESP32 2 80 to 240 MHz 520kB+16kB ESP32-D0WD

ESP32-D0WDQ6

ESP32-D2WD

1 520kB+16kB ESP32-S0WD

ESP32-S2 1 240 MHz 320kB+16kB

Table 1-1. Major Espressif Product Offerings

ESP8266
The hardware of the ESP8266 is quite capable of supporting FreeRTOS . If you use the 
Espressif ESP-IDF (Integrated Development Framework), you can indeed make use of the 
FreeRTOS API there . Unfortunately, the Arduino environment for the ESP8266 does not 
make this available, even though it has been used internally in the build .

To keep things simple for students familiar with Arduino therefore, this book is focused on 
the dualcore ESP32 . What is described for FreeRTOS in this book can also be applied to the 
ESP-IDF for both the ESP8266 and the ESP32 devices .

FreeRTOS Conventions
Throughout this book and in the Arduino source code, I’ll be referring to FreeRTOS function 
names and macros using their naming conventions . These are outlined in the FreeRTOS 
manual, which is freely available for download as a PDF file .[2] These are described in Ap-
pendix 1 of their manual .

While I am not personally keen on this convention, it is understood that the FreeRTOS 
authors were thinking about portability to many different platforms . Knowing their con-
ventions helps when examining the reference API . The following two data types are used 
frequently:

• TickType_t – For the Espressif platform, this is a 32-bit unsigned integer 
(uint32_t), which holds the number of system ticks .

• BaseType_t – For the Espressif platform, this is defined as a 32-bit unsigned 
integer (uint32_t) . The type is chosen to be efficient on the hardware platform 
being used .
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Variable Names
The variable names used in FreeRTOS examples and arguments, use the following prefixes:

• ‘c’ - char type
• ‘s’ - short type
• ‘l’ - long type
• ‘x’ - BaseType_t and any other types not covered above

A variable name is further prefixed with a ‘u’ to indicate an unsigned type . If the value is a 
pointer, the name is prefixed with ‘p’ . An unsigned character variable would use the prefix 
‘uc’, while a pointer to a char type, would be ‘pc’ .

Function Names
Function names are prefixed with two components:

• The data type of the value returned
• The file that the function is defined in

These are some of the examples they provide:

• vTaskPrioritySet() returns a void and is defined within FreeRTOS file task .c .
• xQueueReceive() returns a variable of type BaseType_t and is defined within 

FreeRTOS file queue .c .
• vSemaphoreCreateBinary() returns a void and is defined within FreeRTOS file 

semphr .h .

In this context, the prefix ‘v’ means that the function returns void .

Macro Names
Macro names are given in uppercase, except for a prefix that indicates where they are 
defined (Table 1-2) .

Prefix File Example

port portable .h portMAX_DELAY

task task .h taskENTER_CRITICAL()

pd projdefs .h pdTRUE

config FreeRTOSConfig .h configUSE_PREEMPTION

err projdefs .h errQUEUE_FULL

Table 1-2. Macro name conventions used by FreeRTOS. 

Header Files
Normally when using FreeRTOS there are #include statements required . Within the ESP32 
Arduino programming environment, these are already provided internally . However, when 
you use the ESP-IDF or a different platform, you will need to know about the header files 
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listed in Table 1-3 . Because they are not required in the Arduino code, they are only men-
tioned here .

Header File Category Description

FreeRTOS .h First Should be the first file included .

FreeRTOSConfig .h Included by FreeRTOS .h Not required when FreeRTOS .h has been included .

task .h Tasks Task support

queue .h Queues Queue support

semphr .h Semaphores Semaphore and mutex support

timers .h Timers Timer support

Table 1-3. FreeRTOS Include Files

Arduino Setup
This book uses the installed Arduino IDE rather than the newer web offering . If you’ve not 
already installed the Arduino IDE and used it, you might want to do so now .  If you’re using 
MacOS and recently upgraded to Catalina, you will also need to update your Arduino soft-
ware . The IDE is downloadable from:

 https://www .arduino .cc/en/main/software

Click the appropriate platform link for the install . At the time of writing, the website lists 
the following choices:

• Windows Installer, for Windows XP and up
• Windows Zip file for non-admin install
• Windows App . Requires Win 8 .1 or 10 .
• Mac OS X 10 .8 Mountain Lion or newer .
• Linux 32 bits .
• Linux 64 bits .
• Linux ARM 32-bits .
• Linux ARN 64-bits .

Install guidance or troubleshooting is best obtained from that Arduino website . Normally, 
the IDE installs without problems .

ESP32 Arduino
To add ESP32 support to the Arduino IDE, open File->Preference (see Figure 1-1), Ardui-
no->Preferences for MacOS, and add:

 https://dl .espressif .com/dl/package_esp32_index .json

to your "Additional Boards Manager URLs" text box . If you already have something in there, 
then separate the addition with a comma (,) .
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Figure 1-1. File->Preference dialog.

Next choose Tools->Board->Board Manager (Figure 1-2):

• Then search for "ESP32" and click install (or update), if supporting the ESP32 .

Figure 1-2. File->Board->Boards Manager menu selection.

Figure 1-3 shows the dialog after the ESP addition has been installed . That should be all you 
need to do, to add Espressif support to your Arduino IDE .
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Figure 1-3. Boards Manager after the ESP addition is installed.

ESP Related Arduino Resources
If IDE issues arise, then search the resources found at

https://www .arduino .cc/

If the problem is Espressif related, then there is the following Arduino GitHub page:

https://github .com/espressif/arduino-esp32

C and C++
It surprises some to learn that the Arduino framework uses the C++ language . This may 
be deemphasized to prevent scaring prospective students – a common perception is that 
C++ is diffi  cult . But C++ is increasingly fi nding its way into embedded programming circles 
because of its advantages of stronger type checking among other advantages . The career 
student is therefore encouraged to embrace it .

This book will use a dabbling of C++ language features when it is useful, instructive, or just 
plain preferred . One trivial example is the keyword nullptr is favoured over the old C macro 
NULL . Where C++ classes are used, they are simple objects . No C++ template program-
ming is used in this book, so there is no need for fear and loathing .

There is one area that Arduino users will bump into when looking at Espressif provided ex-
ample code . Most of their examples are written in C . The C language structure initialization 
diff ers from C++, although there are eff orts working towards harmonization . Listing 1-1 
shows a fragment of an Espressif C language wifi  scan example . Notice the initialization 
syntax of the structure named wifi _confi g .
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static void wifi_scan(void)
{
...
    wifi_config_t wifi_config = {
        .sta = {
            .ssid = DEFAULT_SSID,
            .password = DEFAULT_PWD,
            .scan_method = DEFAULT_SCAN_METHOD,
            .sort_method = DEFAULT_SORT_METHOD,
            .threshold.rssi = DEFAULT_RSSI,
            .threshold.authmode = DEFAULT_AUTHMODE,
        },
    };
...
}

Listing 1-1. Espressif examples/wifi/scan/main/scan.c fragment.

Members like  .ssid are set to initialization values using the C language syntax . This style 
of initialization is not yet supported by C++ . Given that Arduino code is C++, you cannot 
copy and paste C language structure initialization code into your program and expect it to 
compile .

Listing 1-2 shows one way it can be reworked in C++ terms (advanced users can also use 
the extern "C" approach) . First, clear the structure completely to zero bytes by using the 
memset() function . Once cleared, the individual members can be initialized as required .

static void wifi_scan(void)
{
...
    wifi_config_t wifi_config;   
    
    memset(&wifi_config,0,sizeof wifi_config);
    wifi_config.sta.ssid = DEFAULT_SID;
    wifi_config.sta.password = DEFAULT_PWD;
...    
    wifi_config.sta..threshold.authmode = DEFAULT_AUTHMODE;
...
}

Listing 1-2. Function wifi_scan() Converted to C++ initialization.

FreeRTOS and C++
FreeRTOS is written in the C language to give it the greatest portability among microcon-
troller platforms and compiler tools . Yet it is quite useable from C++ code since the com-
piler is informed from the header files that the FreeRTOS API functions are C language dec-
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larations . Because these are C language calls, some C++ restrictions naturally follow . For 
example, when using the FreeRTOS queue, you cannot add an item that is a C++ object, 
requiring constructors or destructors .  The data item must be POD (Plain Old Data) . This 
is understandable when you consider that the C language doesn’t support class objects, 
constructors, or destructors .

Arduino FreeRTOS Config
The Arduino environment that is built for your ESP32 uses a predefined FreeRTOS configu-
ration to declare the features that are supported and configure certain parameters . These 
macros are already included for the Arduino but other environments like ESP-IDF, require 
including the header file FreeRTOS .h . Many of the configured values for the ESP32 Arduino 
are provided in Table 1-4 for your convenience . The detailed meaning of these values is 
documented by the FreeRTOS reference manual, which is freely available online .

Macro Value Notes

configAPPLICATION_ALLOCATED_HEAP 1 ESP32 defined heap .

configCHECK_FOR_STACK_OVERFLOW 2 Check for stack overflow by initializing 
stack with a value at task creation time .

configESP32_PER_TASK_DATA 1 Per task storage facility

configEXPECTED_IDLE_TIME_BEFORE_SLEEP 2

configGENERATE_RUN_TIME_STATS 0 Disabled

configIDLE_SHOULD_YIELD 0 Disabled

configINCLUDE_APPLICATION_DEFINED_
PRIVILEGED_FUNCTIONS

0 Disabled

configMAX_TASK_NAME_LEN 16 Maximum name string length

configMINIMAL_STACK_SIZE 768 Idle task stack size (bytes)

configQUEUE_REGISTRY_SIZE 0 Queue registry not supported

configSUPPORT_DYNAMIC_ALLOCATION 1 Dynamic memory supported

configSUPPORT_STATIC_ALLOCATION No support

configTASKLIST_INCLUDE_COREID 0 Disabled

configUSE_ALTERNATIVE_API 0 Disabled

configUSE_APPLICATION_TASK_TAG 0 Disabled

configUSE_COUNTING_SEMAPHORES 1 Counting semaphores enabled

configUSE_MALLOC_FAILED_HOOK 0 Disabled

configUSE_MUTEXES 1 Mutexes enabled

configUSE_NEWLIB_REENTRANT 1 Reentrancy for newlib enabled

configUSE_PORT_OPTIMISED_TASK_SELEC-
TION

0 Disabled

configUSE_QUEUE_SETS 1 Queue sets enabled

configUSE_RECURSIVE_MUTEXES 1 Recursive mutexes enabled

configUSE_STATS_FORMATTING_FUNCTIONS 0 Disabled
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Macro Value Notes

configUSE_TASK_NOTIFICATIONS 1 Task notifications enabled

configUSE_TICKLESS_IDLE No support

configUSE_TIMERS 1 Timer support enabled

configTIMER_TASK_STACK_DEPTH 2048 Svc Tmr task stack size (bytes)

configTIMER_QUEUE_LENGTH  10 Depth of the command queue

configUSE_TIME_SLICING 1 Time slicing enabled (see reference 
manual)

configUSE_TRACE_FACILITY 0 Disabled FreeRTOS trace facilities

Table 1-4. Some ESP32 Arduino FreeRTOS configuration values.

A number of these are of special interest to Arduino users because we can determine that:

• The maximum string name for tasks and other FreeRTOS objects is 16 characters 
(configMAX_TASK_NAME_LEN) .

• There is support for counting semaphores (configUSE_COUNTING_SEMAPHORES) .
• There is support for mutexes (configUSE_MUTEXES) .
• Mutex support includes recursive mutexes (configUSE_RECURSIVE_MUTEXES ) .
• There is support for queue sets (configUSE_QUEUE_SETS) .
• There is support for task notification (configUSE_TASK_NOTIFICATIONS) .
• There is support for FreeRTOS timers (configUSE_TIMERS) .
• The Idle task uses a stack size of 768 bytes (configMINIMAL_STACK_SIZE) .

For portability, the user can use these macros to determine the level of support available .

ESP32 Notes
This section provides a few brief reminders about ESP32 devices . The Espressif web re-
sources and forums are the best places to get more detailed information .

Arduino GPIO References
Arduino maps "digital pin x" to a port and pin combination on some platforms . For example, 
digital pin 3 maps to pin PD3 on the ATmega328P . For the ESP32 Arduino environment, 
digital pin x maps directly to GPIO x .

Input Only
The ESP32 platform also has hardware limitations for GPIO . For example, GPIO 34 to 39 
inclusive can only be used for input. These GPIO pins also lack the programmed pull-up 
resistor feature . For this reason, these inputs should always be used with external pull-up 
resistors for push button and switch inputs to avoid floating signals . A resistance of 10k to 
50k ohm is sufficient .

Reserved GPIOs
Several ESP32 GPIO pins are reserved or are already in use by peripherals . For example, 
GPIO pins 6 through 11 are connected to the integrated SPI flash .

Chapter 1 • Introduction
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GPIO Voltage and Drive
The ESP32 device uses 3 .3-volt GPIO ports and none are 5 volts tolerant . Inputs should 
never be subjected to above 3 .3 + 0 .6 volts (one silicon diode voltage drop) . Voltages 
above 3 .9 volts will subject the built-in protection diode to high currents and potentially de-
stroy it . With the protective ESD (Electrostatic Discharge) diode damaged, the GPIO will be 
vulnerable to damage from static electricity (from the likes of the family cat) . Alternatively, 
the ESD diode can short, causing a general malfunction of the port .

Output GPIOs have programmable current strengths, which default to strength 2 . This is 
good for up to 20 mA .[3]

Programs
Arduino promotes the term "sketch" for their programs . I’ll continue to refer to them as 
programs because this is the more widely accepted term . If the student pursues a career 
in embedded programming, he/she will most likely be using a non-Arduino framework for 
building programs . So I think it best to get comfortable with the term .

Many of the demonstrations written for this book are illustrated using the Wemos Lolin 
ESP32 dev board, which includes the built-in OLED . The OLED is only used by a few of the 
demonstration programs . Even then, some of those demonstrations can use the Serial 
Monitor instead . Otherwise, almost any "dev board" can be used if a reasonable comple-
ment of GPIOs is made available for you to use .

The serial interface brings with it a nagging problem for the Arduino ESP32 . It would be 
desirable to have programs that run both with and without the USB serial interface plugged 
in . Yet it seems that the programs that make use of the serial interface will hang when not 
connected . Yet the Serial Monitor is too useful to forego for debugging and informational 
displays . Consequently, most demonstrations use the serial interface as provided by the 
ESP32 inclusion of the newlib library .[4]  The first printf() call encountered, will assume a 
serial interface at 115,200 baud, 8 bits, no parity, and 1 stop bit . By default, the Arduino 
IDE will provide this in its Serial Monitor .

It may be desirable in some cases to use a demonstration program without the Serial 
Monitor . In that case, comment out the printf() statements and re-flash the recompiled 
program . If it still hangs, look for remaining uncommented printf() calls .

Graphics/Drivers Used
The main graphic driver used is for the Wemos Lolin ESP32 that has the built-in OLED . This 
library is found by using the Arduino Tools -> Manage Libraries and searching for "ESP8266 
and ESP32 Oled Driver for SSD1306 display" by ThingPulse, Fabrice Weinberg .

TTGO ESP32 T-Display
The graphics driver used for the TTGO ESP32 T-Display unit is the driver found by the Ar-
duino Tools -> Manage Libraries and searching for "TFT_eSPI" by Bodmer (version 2 .1 .4 
was tested) . This driver requires further editing before it can be used (see Chapter 9, In-
terrupts) .

FreeRTOS with Arduino UK 200525.indd   28FreeRTOS with Arduino UK 200525.indd   28 08-06-20   17:0308-06-20   17:03



● 29

M5Stack
M5Stack examples in this book require that you’ve installed the drivers found by the Ardui-
no Tools -> Manage Libraries and searching for "M5Stack" . Choose and install the library 
"M5Stack" by M5Stack . Version 0 .2 .9 was tested in this book .

Assumptions about the Reader
This book is targeted to new and advanced Arduino users alike . The new student will 
discover the benefits of FreeRTOS design by wading gently into RTOS concepts and the 
API . The advanced user looking to become familiar with FreeRTOS can quickly familiarize 
themselves with the API . The emphasis was placed on the practical but some background 
material is provided for the benefit of new students .

Because this book is focused upon FreeRTOS, the reader is assumed to have some familiar-
ity with the ESP32 and the Arduino API . Activities like configuring and flashing the correct 
board from the Arduino IDE is assumed . Those encountering difficulties in these areas are 
encouraged to seek help from online documentation and forums for Arduino and Espressif .

Summary
At this point, I expect that you are champing at the bit to get started . By now, your Arduino 
IDE has been made ready and you have some ESP32 hardware ready to play with . Let’s 
begin that journey of discovery into FreeRTOS!

Web Resources
[1] https://en .wikipedia .org/wiki/Arduino
[2] https://www .freertos .org/Documentation/FreeRTOS_Reference_Manual_V10 .0 .0 .pdf
[3] https://www .esp32 .com/viewtopic .php?t=5840
[4] https://sourceware .org/newlib/
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qualities of an ISR 166
quasi-bidirectional device 271
query the current event group bit values 
241
queue 52, 117, 118, 132, 141, 

152, 153, 191, 192, 194, 
196, 198, 202, 203, 267, 286

queue depth 53, 57, 60
queue depths 192
queue handle 56
queue is full 58
queue object 54
queue overwrite 129
queue peek 129
queues 191, 192, 199, 261, 285
queue set 191, 194, 196, 198
QueueSetHandle_t 192
queue sets 199
Queue sets 202
Queue Set Traps 193
quirk of the PCF8574 chip 156

R
race condition 198
race conditions 291
rand() 167
random seed value 108
rand_r() 167
Range finding 169
Ready 132
ready state 58
Ready state 131, 132, 139, 140, 149
ready task 131, 149
Real-time priority 150
Rebooting 249
recursively 167
recursive mutex 163, 164, 165
recursive Mutex 155
reentrant 167
reentrant routines 167
reference 196

register 116, 117
register optimizations 117
registers 30
register save and call convention 168
relative humidity 120
releasing the mutex 153
reneging 53
Reneging 52
reset 150
restart 150
resumption 44
RF24 .h 290, 291
RISING 169
rising edge 169
rising pulse 169
risks 165
round-robin 48, 49, 131, 133, 

142, 149, 150
Round-Robin 139
round-robin scheduling 49, 139
round-robin unfairness 143
routine in one place 197
RTOS daemon 252
RTOS daemon task 77, 241
running 80
Running 79, 132
running out of stack space 285
Running state 132

S
safety-critical applications 268
scheduler 30, 139, 149, 177, 197, 253
scheduler component of FreeRTOS 139
scheduling 131
scheduling can be unbalanced 143
schematic 119, 156, 177, 194, 205, 264
Schematic diagrams 293
SCL 156, 157, 272
scope capture 46
scope rules 286
scoping rules 291
SDA 156, 157, 272
SDK 39
self 42
semaphore 97, 119, 152, 198, 202, 203
semaphores 191, 261, 285
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send a pointer through a queue 285
sending data items by pointer 73
sensor modules 119
sequencing of the locks 114
serial interface 28
serial monitor 37, 227
Serial monitor 60
Serial Monitor 28, 99, 104, 106, 107, 

119, 123, 133, 135, 158, 159, 
205, 208, 218, 225, 246, 249, 

264, 272, 284, 288
serial monitor output 35
Serial Monitor output 134, 135
setup() 31, 32, 35, 36, 60, 67, 

84, 86, 97, 105, 108, 121, 131, 
133, 136, 141, 150, 157, 193, 196, 
198, 205, 246, 267, 283, 284, 286

Setup25_TTGO_T_Display .h 187
share one ISR routine 197
share the CPU 48
Si7021 118, 119
Si7021 sensor 119
signal generator 169
signal level translations 99
silencing of the speaker 
on the M5Stack 189
simultaneous access 151
single or multiple queuing sources 53
sink current 156
sinked 264
sketch 28
slave devices 151
Smart Notify 213
SMP 139
snprintf() 77
Soc 17
sole owner 151
source current 156
sourced 264
special calling requirements 166
special case of the queue 129
spin lock 253
spinning 47
SPI RAM 39
SRAM 17, 19, 60
SSD1302 140

SSD1306 28, 140, 177
SSD1306 OLED 99
stack 17
stack bytes 35
stack for ISR routines 167
stack high water mark 38
stack size 37, 40
Stack size 36
stack size limitations 76
stack space 77
StackType_t 40
stack usage 38
starts the FreeRTOS scheduler 130
state machine 17
states of a FreeRTOS task 132
static 286
static electricity 28
"static" keyword 40
static keyword 286
static queue 55
static queues 54
StaticTimer_t 80
std::string 73
stop bit 28
strdup() 73
struct 35, 196
stubbing out your application 285
stub functions 283
suffix "FromISR" 73
support tasks 31
suspend 39
suspend and resume tasks 43
suspended 149, 150
Suspended 132
Suspended state 132
suspending 137
suspending a task 44
suspension 44
symmetric multiprocessing 139
synchronization 97, 254
synchronize 97
synchronizing 98
synchronous event 52
system tick 177
system tick interrupt 131, 142, 

149, 168, 253

FreeRTOS with Arduino UK 200525.indd   310FreeRTOS with Arduino UK 200525.indd   310 08-06-20   17:0308-06-20   17:03



Index

● 311

system timer ticks 131

T
take 97, 98, 154, 158
taken 97, 151, 154
taking 98
task 30, 117, 131, 166, 203
task context change 139
Task Control Block 39
Task Control Block (TCB) 38
task creation 31
task deletes another 43
task deletes self 43
taskENTER_CRITICAL() 253
task event notification 203
task event word 204
task execution 203
taskEXIT_CRITICAL() 253
task handle 37, 40, 42, 44, 258
task handles 35
tasklocal .ino 256
task local storage 243
tasknfy1 .ino 207
tasknfy3 .ino 212
tasknfy4 .ino 214
tasknfy5 .ino 219, 222
task notifications 223
task notification word 204
task notify event word 210, 212
task preemption 46
Task preemption 51
task priorities 31
task priority 130
task ready list 139
tasks 17, 285
tasks blocked waiting for a queue 57
taskSCHEDULER_NOT_STARTED 259
taskSCHEDULER_RUNNING 259
taskSCHEDULER_SUSPENDED 259
task slices 46
task’s local storage 258
task’s stack size 37
task that has been suspended 132
task that is all ready to go 137
taskYIELD() 47, 48, 49, 63, 133
TCB 40

TCP/IP 31, 37
TCP/IP networking 19
temperature 120, 122
temporarily boosted 165
temporary boost 153
temporary priority boost 154, 165
TFT_eSPI 28, 186
TFT_eSPI .h 186
threshold 0 170
threshold 1 170
threshold interrupts 170
threshold status 176
throw-away code 289
throwie 114
tick interrupt 117
tick interrupts 143
tick period 47
ticks 204
TickType_t 20, 91
timeout 30, 236
timer 18, 143
timer callback 76, 78
timer command queue 77
timer daemon task 130
timer ID 77
timer instances 77
timer service task 77
timer tick 116
Time Sharing Option 17
time slice 18, 30, 44, 47, 48
time slices 131
tips 282
"Tmr Svc" task 77
trial measurements 172
trickle-down effect 144
troubleshooting 158
Troubleshooting 179, 187, 189, 272
TSO 17
TTGO ESP32 T-Display 169
TTGO ESP32 T-Display unit 28, 186
TTL to serial device 19
type option 289

U
udp_broadcast() 226
UDP broadcast server 227
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UDP packets 228, 229
uint64_t 174
ulBitsToClearOnEntry 213
ulBitsToClearOnExit 213
ulTaskNotifyTake 204
ulTaskNotifyTake() 204, 205, 206, 

207, 212
ultrasonic module 98
ultrasonic transducers 99
UML 285
unblocked 58, 59, 123, 152, 153, 177
unblocks 97
unequal execution time 150
unequal time slices 143
unit testing 261
unlock 154, 163
unlocked 154, 157
unlock too many times 163
Unreported errors 50
unused stack bytes 31
update the mailbox value 117
USB to serial interface 225
user provided callback 76
User_Setup .h 186
User_Setup_Select .h 186, 187
USE_SSD1306 99
uxBitsToSet 236
uxBitsToWait 224
uxBitsToWaitFor 224, 236
uxQueueMessagesWaiting() 72
uxQueueSpacesAvailable() 72
uxSemaphoreGetCount() 98
uxTaskGetNumberOfTasks 259
uxTaskGetStackHighWaterMark() 35

V
validation 19
variable length line of text 73
vEventGroupDelete() 241
virtual GPIO number 262
volatile 117
volatile attribute 117
volatile keyword 116
voluntary context switch 49
voluntary context switches 51
vSemaphoreDelete 155

vTaskDelay 75
vTaskDelay() 76, 90
vTaskDelay(10) 144
vTaskDelayUntil() 92, 95, 105
vTaskDelete() 42, 43
vTaskDelete(nullptr) 284
vTaskPrioritySet() 133
vTaskResume() 132, 138
vTaskSetThreadLocalStoragePointer 256
vTaskStartScheduler() 130
vTaskSuspend() 132
vTaskSuspendAll 259
vulnerable to exploits 291

W
wait for a notification 204
wait_ticks 55, 56
wakeup flag 206
watchdog 247, 249, 252
watchdog1 .ino 246
watchdog is triggered 246
watchdog timer 243, 246, 251
watchdog timer reset call 244
watchdog timers 150, 243
Wemos Lolin ESP32 28, 169, 

172, 177, 178
Wemos Lolin ESP32 dev board 28
WiFi 19, 31, 37, 98, 226, 229
WiFi credentials 225
WiFi facility 226
WiFi router 225, 226, 229
Windows Subsystem for Linux 289
wiring diagram 293
woken 176, 177, 197
WSL 229, 289

X
xClearCountOnExit 204, 205
xClearOnExit 224
xEventGroupClearBits 241
xEventGroupClearBitsFromISR() 241
xEventGroupCreate 223
xEventGroupCreateStatic 223
xEventGroupGetBits() 241
xEventGroupGetBitsFromISR() 241
xEventGroupSetBits 226
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xEventGroupSetBits() 223, 224, 242
xEventGroupSetBitsFromISR 242
xEventGroupSetBitsFromISR() 223
xEventGroupSync() 236, 237
xEventGroupWaitBits() 223, 224, 242, 269
XGPIO 262, 263, 267, 268, 270, 271
XGPIO to pin mappings 262
xIndex 256
xPortGetCoreID() 36
xPortGetFreeHeapSize() 42
xQueueAddToSet 192
xQueueAddToSet() 192, 193, 194
xQueueCreate 57, 118
xQueueCreateSet() 198
xQueueCreateStatic 55
xQueueDelete 57
xQueueOverwrite 117
xQueueOverwrite() 118
xQueuePeek() 73, 118, 123
xQueueReceive 56, 57
xQueueReceive() 63, 118, 191, 193, 199
xQueueReset 57
xQueueReset() 68, 71, 73
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